1. HDR projects – Quick guide ................................................................. 4
  Importing images .............................................................................. 4
  Setting up the HDR parameter ......................................................... 6
  Tone mapping and Post-processing .................................................. 7
  Saving the final image ....................................................................... 8

2. Program & interface ........................................................................ 9
  2.1 Interface .................................................................................... 10
  2.1.1 The File menu ....................................................................... 10
  2.1.2 The Projects submenu ......................................................... 11
  2.2 The Edit menu ............................................................................ 11
  2.3 The View menu .......................................................................... 12
  2.4 The Extras menu ....................................................................... 13
  2.5 The Settings window .................................................................. 14
  2.6 The Information menu .............................................................. 16
  2.7 Drag & Drop .............................................................................. 16
  2.8 Toolbars .................................................................................. 17
  2.8.1 Main toolbar ....................................................................... 17
  2.8.2 Image area toolbar ............................................................. 19
  2.8.3 Image area ......................................................................... 22
  2.8.4 Progress bar ....................................................................... 23
  2.8.5 Modifying the interface ....................................................... 23

3. HDR creation .................................................................................. 24
  3.1 HDR preparation .................................................................... 24
  3.1.1 Colour space conversion .................................................... 25
  3.1.2 White balance ..................................................................... 25
  3.1.3 Colour noise suppression .................................................. 26
  3.1.4 Exposure optimisation ....................................................... 26
  3.1.5 Automatic alignment .......................................................... 27
  3.1.5.1 Shift and automatic cropping ....................................... 27
  3.1.5.2 Turns, shearings, movement ....................................... 28
  3.1.5.3 Genetic algorithms ...................................................... 29
  3.1.6 Automatic ghosting correction ........................................... 30
  3.2 The work area exposure bracketing ........................................ 30
  3.2.1 Synthetic exposure bracketing images .................................. 32
  3.2.2 Global weight & Exposure value ....................................... 33
  3.3 The work area of HDR algorithms .......................................... 34
  3.3.1 An overview of HDR algorithms ....................................... 35
  3.3.2 Parameters of HDR algorithms ......................................... 36

4. Tone mapping / post-processing ...................................................... 38
  4.1 Default settings ....................................................................... 38
  4.1.1 Combining default settings ................................................. 41
  4.2 Tone mapping expert mode ..................................................... 42
  4.2.1 Tone mapping algorithms .................................................. 42
  4.2.2 Post-processing filters ....................................................... 43
  4.2.3 Selected effects .................................................................. 45
  4.2.3.1 Parametrisation ......................................................... 47

5. HDR paint mode ............................................................................ 48
  5.1 Weighting view vs. HDR view .................................................. 50
  5.2 Selecting the work colour ........................................................ 51
  5.3 Brush mode Increase weighting ............................................. 51
  5.4 Brush mode Blurring ............................................................... 52
  5.5 Brush mode Delete .................................................................. 52
  5.6 Stamping mode ....................................................................... 53
  5.7 Brush mode Reduce weighting .............................................. 54

6. Batch processing ........................................................................... 55
  6.1 Source file ............................................................................... 56
  6.1.1 Allocation/Automatic exposure bracketing detection .......... 56
  6.2 Results .................................................................................... 57
  6.2.1 Format ............................................................................... 57
  6.2.1.1 Batch processing with re-sort mode ......................... 58
  6.3 Processing settings ................................................................. 58
  6.4 Exposure bracketing preview ................................................ 59
  6.4.1 Allocated exposure bracketings ....................................... 59
  6.5 Progress bar .......................................................................... 61
  6.6 Direct Start button .................................................................. 61
  6.7 Preview during processing ...................................................... 61

7. Ports and plugins .......................................................................... 62
  7.1 Configuration with HDR projects .......................................... 62
  7.2 Configuration of the plugins for Photoshop CS6 and Photoshop Elements ......................................................... 63
  7.3 Configuration of Adobe Lightroom 4 ..................................... 64
  7.4 Triggering external programs .................................................. 65
1. HDR projects – Quick guide

In order to quickly achieve good results the following four basic steps are all that you need to know:

1. Importing images
2. Setting up the HDR parameter
3. Tone mapping post-processing
4. Saving the final image

If you want to learn more about the possible settings of HDR projects, please skip to chapter 2. There you will also find some tips & tricks that will help you to improve your final image.

1 Importing images

In order to import a single image (HDR from a single image), an exposure bracketing (multiple images) or a project file (.hdrproject), simply drag and drop them into the program window. You can alternatively use the toolbar or the file menu.

As soon as you have chosen a single image or an exposure bracketing the HDR preparation window will pop up.

Here you have the following editing steps for the HDR preparation:

- choose a colour space
- switch between automatic or manual white balance
- the degree of colour noise suppression, with optional correction of hot pixels
- exposure optimisation and optimisation of dark areas
- automatic alignment of the image
- automatic ghosting correction

You can find a detailed description of these steps in chapter 3 or in the information section within HDR projects. In most cases the default settings are sufficient to achieve good results.

As soon as you confirm the settings by clicking on the arrow Apply settings the importing process and the preparation of the image with your chosen settings will start. After import and preparation of the image is complete you will see the dialogue for the HDR parameters.
2 Setting up the HDR parameter

The screen will now be divided into different areas:

1 Exposure bracketing
2 Toolbar
3 HDR preview
4 HDR algorithms
5 Information on the currently selected area

You can now edit single images from the exposure bracketing section (on the left), for example, by changing the exposure, excluding an image from the HDR creation or editing the global weight a single picture has to the final result.

The special characteristic of synthetic exposure bracketing in HDR projects is explained in detail in chapter 3.2.1.

With the HDR algorithms (on the right) you can fine-tune the creation of the HDR image to your motif. For this purpose you have eleven HDR algorithms at your disposal which all have different parameters (see chapter 3.3.1.).

When you have chosen the desired setup for the HDR area, click on the palette symbol in the toolbar to proceed to the tone mapping and post-processing.

3 Tone mapping and Post-processing

This screen is divided into the following areas:

1 Default settings
2 Toolbar
3 Tone mapping preview
4 Tone mapping and Post-processing effects
5 Information on the currently selected area

Select one of the default settings on the left (Preset) that fits to the motif on your image (Landscape in our example). The default settings included in HDR projects are now displayed and you can choose one by left-clicking on it (powerful colours in our example). You can see all the effects used in this default setting in the expert mode bar on the right where all the selected filters are displayed. You can configure the list of effects as you wish by adding, removing or re-sorting effects. If you want to adjust an effect’s parameters, click on the effect. The parameters are now displayed underneath the lists of effects. The special characteristic of the button Combine default settings (top left in our example) is explained in chapter 4.1.1.
### Saving the final image

You can now save the final image by left-clicking on the disk symbol (**Save final image**) in the upper toolbar.

Choose a file path and a format (.tif, .tiff, .jpg, .exr or .hdr) for the final image and enter a file name.

If you have performed all of these steps without coming across the software’s preview mode (chapter 2.4.2), the following question will be displayed:

![Warning](image)

Confirm by clicking **Yes** in order to calculate your image in its highest resolution and to save it.

Congratulations! You have just created your first impressive HDR image with HDR projects!

### 2. Program & Interface


Generally there are no restrictions towards importable picture sizes, but with the 32-bit version for Windows you will experience a limited maximum size of 22 megapixels per single image in an exposure bracketing. This is due to the operating system’s limitations. Exposure bracketings can consist of up to 18 single images.

All known camera raw image file formats and almost all image formats are supported by the software:

<table>
<thead>
<tr>
<th>Image formats supported by HDR projects</th>
<th>Image formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera RAW formats</td>
<td>.tiff</td>
</tr>
<tr>
<td>Canon RAW (.crw,.cr2)</td>
<td>.bmp</td>
</tr>
<tr>
<td>Fuji RAW (.raw)</td>
<td>.dds</td>
</tr>
<tr>
<td>Hasselblad (.tiff,.3fr)</td>
<td>.exr</td>
</tr>
<tr>
<td>Leica RAW (.dng)</td>
<td>.gif</td>
</tr>
<tr>
<td>Kodak RAW (.dcr,.dcr)</td>
<td>.hdr</td>
</tr>
<tr>
<td>Minolta RAW (.mrw)</td>
<td>.ico</td>
</tr>
<tr>
<td>Nikon RAW (.nef,.nrw,.nrf)</td>
<td>.iff,.libm</td>
</tr>
<tr>
<td>Panasonic RAW (.raw,.rawl)</td>
<td>.jpg</td>
</tr>
<tr>
<td>Pentax RAW (.pef)</td>
<td>.jpeg,.jff</td>
</tr>
<tr>
<td>RAW (.x3f)</td>
<td>.jpg2000</td>
</tr>
<tr>
<td>Sony RAW (.sr2,.srf,.arw)</td>
<td>. Kodak PhotoCD,.pcd</td>
</tr>
<tr>
<td>Olympus RAW (.orf)</td>
<td>.pcx</td>
</tr>
<tr>
<td></td>
<td>.pict,.pct</td>
</tr>
<tr>
<td></td>
<td>.png</td>
</tr>
<tr>
<td></td>
<td>.raw (Sun)</td>
</tr>
<tr>
<td></td>
<td>.sgi</td>
</tr>
<tr>
<td></td>
<td>.targa/.tga,.tif,.tiff</td>
</tr>
</tbody>
</table>
All calculation areas support multithreading with up to 32 CPU cores. In addition, HDR projects uses the full capacity of your graphics card which makes it an effective tool for the creation of HDR images.

2.2 Interface

HDR projects uses an interface that follows the modern guidelines of an ergonomic user guide and contains detailed tooltips for every button.

In order to trigger an operation simply left-click on the corresponding button. Many buttons have context menus that you can access by right-clicking on the button.

Of course you can access many essential functions with hotkeys. For example, simply press $F9$ in order to switch to the HDR area, press $F8$ to go to the HDR paint mode and press $F7$ to go to the tone mapping dialogue.

The main menu contains all functions of the software and is divided into five main areas:

The following chapters will explain these five functions in detail.

2.2.1 The File menu

With the File menu you can open and save HDR images and projects. The menu is subdivided into:

Start: With Start you can go back to an empty work screen (like the one that appears when you start the software). You will be asked if you want to save the current project before it gets deleted from the software’s memory.

Importing images: Here you have three options to choose from:

With HDR from a single image you can import a single image. By selecting Import exposure bracketing you can import more than one image of a single bracketing. The option Exposure bracketing browser... performs an automatic search for images that belong to the same bracketing.

Save final image: Here you can save the current image as your final image any time.

Projects: This option takes you to a submenu that will be explained in detail in the following chapter.

2.2.1.1 The Projects submenu

The Projects submenu is a special feature of HDR projects. With this feature you can create project files (.hdrproject) that let you save all the changes that you have performed in one exposure bracketing at any time.

With this option you can open (Open project), overwrite (Save project) and save projects under a different name (Save project as...).

Note: Projects take up a significant amount of space on your hard drive; nevertheless they allow you to quickly load and continue an unfinished project.

2.2.2 The Edit menu

With the Edit menu you can switch between three different modes: Edit exposure bracketing $F9$, Edit weightings $F8$ and Tone mapping/post-processing $F7$. 
2.2.3 The View menu

With the View menu you can add or remove additional windows, change the frame colour for the image area and reset your configuration of the interface to the default settings (see chapter 2.7).

Information windows (Control I): In this window you can find context sensitive information about your current work area at any time.

Exif information window (Control E): The EXIF information for the currently selected image of the exposure bracketing will be displayed. If no image has been selected, the EXIF information for the master image (the centre image) will be displayed.

HDR histogram (Control H): In the HDR histogram you can individually activate or deactivate the distribution of luminance and the colours red, green and blue.

The option cumulative allows you to display a summarised histogram. This may be helpful when you are trying to take a closer look at the brightness control within an image.

Note: By left-clicking on the histogram you can transfer it to the image area, and watch and analyse it in a higher resolution.

Interface style: Here you can choose from four variants of the whole interface—purple, dark gold, dark grey (default setting) and light grey.

Frame colour: You can choose from two modes for the frame colour which will be displayed around your image.

Grey card: The grey card is the classic grey value of photography with a fixed brightness value of 18%.

Automatic (ambient colour frame): The automatic frame colour mode is a special feature of HDR projects. It automatically calculates in real time and displays the optimum frame colour based on your current final image.

Restore window defaults: With this option you can reset the interface configuration to the default settings.

2.2.4 The Extras menu

In the Extras menu you can access the following features of HDR projects:

Batch processing (Control B): HDR projects batch processing is explained in detail in chapter 6.

HDR preparation: Chapter 3.1 deals with the separate settings for the HDR preparation. Here all settings that prepare an image for HDR editing are configured.

Settings (Control P): This opens the detailed window for software settings and calculation options. Refer to the coming pages for further information on this.
2.2.5 The **Settings** window

1. **Program location**
   Here you can set the standard locations for importing and exporting data:
   - **Projects**: The default path for project files (.hdrproject)
   - **Exposure bracketing**: The default path for exposure bracketing files
   - **Single images**: The default path for single images (HDR from a single image)
   - **Final images**: The default path for your final images
   You don’t have to set these default paths, but if you do it will simplify the loading/saving of your images.

2. **External Programs**
   HDR projects can send final images directly to other applications. Here you can enter the file (.exe) of the application that you would like to export final images to.

3. **Gamma conversion**
   Here you can set the gamma value for the development of images for all floating point file formats, which are HDR images in the formats .hdr and .exr.

4. **Language**
   Here you can set the interface language to German or French. You need to restart HDR projects for the language change to take effect.

5. **Preview mode**
   All calculations in preview mode are performed with a reduced image size in order to speed up the processing. You can select a resolution in megapixels on the right or you can choose one of the two default settings: **optimal** or **quick**. The former fits the size of the preview to the display area while the latter uses half of the display area and is primarily used for the real-time animation mode in the post-processing module.

6. **Restore settings to standard values**
   Left-clicking this button will reset all options in this window to the default settings.
2.2.6 The Information menu

In the Information menu you can directly access the HDR projects homepage which will be loaded onto your standard web browser. The option Help will open via the external PDF viewer used on your system. By clicking on Go to updates page you will directly enable HDR projects’ update service where you can download a new/updated version of HDR projects. Further information on HDR projects including the current version, the credits and the external licences, can be found under the menu About HDR projects.

2.3 Drag & Drop

HDR projects’ extensive Drag&Drop support enables you to drag files to the software interface and just drop them by releasing the mouse button. Drag & Drop is context sensitive and can decide automatically which function to use depending on the imported file:

- Single image files activate the function HDR from a single image
- Multiple image files activate the function Import exposure bracketing
- .hdrproject files activate the function Open project
- Folders starts the batch processing with the content of the imported folder

2.4 Toolbars

HDR projects has two toolbars that show the available options depending on the context. Options that you cannot use will consequently be omitted for clarity.

2.4.1 Main toolbar

After starting the software you can find the main toolbar at the top left of the screen, but you can drag it to another location if you like. If you have imported an exposure bracketing, the toolbar looks as follows:
2.4.1 Main toolbar (continued)

1. Start
   Closes the current project after asking if you would like to save it and returns you to an empty start page.

2. Save project
   Saves the project under the current name. If you have not given a name to the current project, the function Save project as... will be used instead.

3. Editing modes
   The button with the three images and the wheel lets you switch between HDR- and Edit exposure bracketing at any time. The brush button for Edit weightings activates the HDR paint mode. Detailed information on this mode can be found in chapter 5. Clicking on the colour palette button will start the tone mapping and post-processing mode.

4. Save final image
   This button opens the window where you can save the current image. If you are currently in the HDR area, the HDR image will be saved. If you are in tone mapping/post-processing mode, the image that has been treated with tone mapping will be saved.

5. Open final image in external program
   Starts the external software stated in the program settings and uploads the current final image into this software.

6. Create restore point
   With this you can create a restore point for the current state of your work before you make significant changes to the settings/calculation values.

7. Revert to restore point

8. Panorama view
   Opens a new window for a 360° panoramic view of the current project.

9. Information windows
   With these three buttons you can open the program information window, the window for the EXIF data and the histogram window.

2.4.2 Image area toolbar

1. Preview mode (here shown as on)
   In preview mode your image will be downsized to 1 megapixel, and all calculations are performed with this smaller image size in order to enable you to work in real time without any waiting times no matter how large your original image is.

2. Real-time calculation mode (here shown as on)
   If real-time calculation mode is activated, all the changes you make will be immediately calculated into a new final image. If this mode is not active and you make changes to your image, the button re-calculate will be available.

3. Re-calculate
   This button triggers the calculation of a new final image with the current settings.

4. Show border pixels
   The button show border pixels is only available during Tone mapping/post-processing. Yellow or red pixels indicate brighter areas while blue and violet pixels indicate darker areas. Note that further editing of these two areas might cause a loss of detail in the image.
2.4.2 Image area toolbar (continued)

3 Original resolution view
Use the button **Original resolution view** to set the zoom factor to 100%. One pixel on screen will then be equivalent to one pixel in the final image.

6 Zoom control
With the zoom control you can smoothly regulate the zoom factor between 10% and 1000% in real time. As interpolation would work exactly on the scale of single pixel areas this feature was not included here.

7 Monitor size
With this button you can set the zoom to monitor size and display the whole image at as high a zoom as possible.

8 Additional functions
This button opens a section of the toolbar with six additional functions:

1 Horizontal mirroring
Mirrors the whole exposure bracketing, the HDR weighting matrices and the final image horizontally.

2 Vertical mirroring
Mirrors the whole exposure bracketing, the HDR weighting matrices and the final image vertically.

3 90 degree rotation (anti-clockwise)
Rotates the whole exposure bracketing, the HDR weighting matrices and the final image by 90 degrees anti-clockwise.

4 90 degree rotation (clockwise)
Rotates the whole exposure bracketing, the HDR weighting matrices and the final image by 90 degrees clockwise.

5 Align shifts in the exposure bracketing
Checks the exposure bracketing for misalignments in the shifts. If the program finds a better alignment for the exposure bracketing, it will automatically be used.

6 Align shears and moves in the exposure bracketing
Checks the exposure bracketing for misalignments in the shears and moves. If the program finds a better alignment for the exposure bracketing, it will automatically be used.

**Note:** You can use these two alignment functions in the additional functions toolbar to subsequently align images. If the exposure bracketing has already been aligned using these alignment algorithms during the HDR preparation, it is usually not possible to achieve better results with these functions.
2.5 Image area
The image area is the centre area in HDR projects and has an additio-
nal status bar.
To zoom in and out on the image simply use your mouse wheel or the
multi-touch mouse of your Macintosh.

![Image area](image1.png)

To change the displayed area of an image simply click in the image,
hold down the mouse button and drag your cursor over the image.
If you have zoomed in, this will open a small window with an over-
view of your image that will help you to keep track of where you are
inside your motif.
The status bar on the bottom part of the screen shows you some ba-
sic data on the motif, such as the resolution, the number of megapi-
xels, the ISO value of your images, the current cursor position and the
pixel colour at the current cursor position.

2.6 Progress bar
The progress bar shows you what is currently being calculated and the
progress of the calculation.

![Progress bar](image2.png)

If an error occurs during calculation, the info part of the progress bar
will display the various steps of the calculation with different colours:

- **green**: This step has been successfully completed.
- **yellow**: This step resulted in a warning.
- **red**: This step caused an issue.

2.7 Modifying the interface
You can modify the HDR projects interface according to your pre-
ferences. This means that you can drag any work area, toolbar or
information window to any given place on the screen or even on a
second screen.
In order to unlock an area from the interface (disconnecting), dou-
ble-click on the respective title bar or just drag the area out of the
interface by holding down the mouse button while pointing at the
title bar.
You can attach the window back to the main interface in the same
way. Double-clicking on the title bar will move the area back to its
original position in the main interface. You can also move the area to
a new position within the interface if you prefer.
3. HDR creation

**HDR creation** is the basis for a good final image from an exposure bracketing or for the function **HDR from single image**. HDR projects uses the following basic steps for this:

- HDR preparation (chapter 3.1)
- Optimising the exposure bracketing (chapter 3.2)
- Choosing an appropriate HDR algorithm (chapter 3.3)

The possibility to optimise the exposure bracketing and the ability to choose and change the parameters for different HDR algorithms are probably new to you since these methods have never been used in comparable softwares before.

3.1 HDR preparation

**HDR preparation** is the first step towards a good result for your HDR final image:

Here you can set the steps for the transformation of your imported images. These steps will be calculated after the loading process. The transformation steps in detail are:

- Colour space conversion
- White balance
- Colour noise suppression
- Exposure and dark areas optimisation
- Automatic alignment
- Automatic ghosting correction

Click on the arrow (**Apply settings**) on the bottom right of the screen to apply those settings.

3.1.1 Colour space conversion

HDR projects lets you choose from nine **colour spaces**, especially for camera raw images. The default setting is the **Adobe RGB colour space**, which was defined by Adobe Systems in 1998. Many programs like Photoshop or Lightroom use this colour space. If you are not sure which colour space to use, just use the **Adobe RGB colour space** or alternatively the **standard RGB colour space**.

3.1.2 White balance

With **White balance** you can correct colour fog, which can be caused by taking a photograph in special environments, such as in a room with coloured lighting or outside during the "blue hour" (twilight). The balance colour is given as colour temperature in Kelvin, usually between 1000 K and 16500 K. Choose your preferred balance from the default settings or use the colour temperature control underneath the default settings.
3.1.3 Colour noise suppression

HDR projects provides you with three options when it comes to colour noise suppression:

**Edge definition:** Choose between a low value (5-10%) for a weak edge definition and a high value (50% or more) for a strong edge definition if your images have a high colour noise.

**Denoise darker images more strongly:** When you take an exposure bracketing the images taken with less exposure time (the darker pictures) have a higher colour noise than the brighter ones. If this is the case for your motif, choose to denoise the darker images more.

**Correct hot pixels:** Hot pixels are pixels for which the incoming light has not been calculated correctly by your camera’s sensor. These pixels appear too bright or in the wrong colour. If you activate HDR projects’ hot pixel correction, these pixels will be automatically deleted when you upload an image.

3.1.4 Exposure optimisation

Exposure optimisation transforms your exposure bracketing into a state that is optimal for HDR creation. This means that the images you have taken will be automatically sorted in an optimal way based on their exposure.

**Example:** You have created an exposure bracketing with 5 images and the second image file has somehow been lost. If you activate the option **Exposure optimisation** the bracketing will automatically be recalculated to make it as if you only had 4 images. This way you will not have any gaps in your exposure bracketing.

**Optimise dark areas:** This is an important step for all images with very dark areas because these areas are especially prone to colour fog. See the example on the next page for the effect of an optimisation of dark areas. The picture on the right (optimised dark areas) shows no colour fog while the image on the left (no optimised dark areas) shows a yellow-brown fog.

3.1.5 Automatic alignment

You can use the automatic image alignment to correct shifts, turns, shearings and movement that happened when you were taking an exposure bracketing. These image faults are often caused by taking exposure bracketings unaided.

**3.1.5.1 Shift and automatic cropping**

The most common error in exposure bracketings is the "camera shake".

**Note:** Automatic alignment of your exposure bracketing requires a lot of calculation time during import. If you are sure that your exposure bracketing is not blurred, you can deactivate this option in order to improve upload times.

**Automatic cropping** is part of the alignment when it comes to moving images. This option erases empty areas at the edges of your images that usually appear when you have to shift/align an exposure bracketing.
3.1.5.2 Turns, shearings, movement
Another variant of a fault in an exposure bracketing is the "twisting" of the camera while taking a photograph or moving objects. For the latter you have to figure out if the error is due to a ghost image or if it is a flaw that can be corrected with an image alignment.

As a rule of thumb see the following:

- A **flaw** occurs if you have an object that moves within itself, such as a flame or objects that move with the wind.
- **Ghost images** are objects that move a certain distance within the time it takes to take one exposure bracketing, for example a person or a vehicle (see chapter 3.1.6).

Let’s come to one of the great obstacles in automatic image alignment: the moving flame of a candle in an exposure bracketing containing 10 images.

On the right you can see the candle flame that has been aligned with HDR projects. Compare with the unaligned original on the left. The result is already pretty good, but it can be made even better with **genetic algorithms** that are further explained in the following chapters.

3.1.5.3 Genetic algorithms
**Genetic algorithms** are a specially developed iterative method to optimise the alignment of exposure bracketings. HDR projects is the first software to use this method.

The genetic algorithm can be added to other alignment measures, which means that in order for the genetic algorithms to have an effect you must activate one of the basic methods first.

**Note:** When you activate genetic algorithms the time it takes for the automatic alignment to be processed can be up to 4 times longer.

Let’s have another look at the candle flame:

On the left you can see the exposure bracketing with standard alignment measures being used. On the right you can see the same exposure bracketing after genetic algorithms have been applied—the result is a very still and calm flame.
3.1.6 Automatic ghosting correction
With the **automatic ghosting correction** you can treat moving objects within an exposure bracketing when these objects have travelled a certain distance within the bracketing.

On the left you can see a typical situation that leads to ghost images: an exposure bracketing containing three images that shows a busy street. The cars in the lower third of the image were moving while the bracketing was being taken. Therefore, you can see a row of semi-transparent vehicles. On the right you can see the corrected version: the ghost images of the vehicles have disappeared.

Additionally, you can define the edges of the ghost images in HDR projects. A low value uses a soft form of correction while a high value uses a sharper form of correction.

3.2 The work area exposure bracketing
As soon as you have uploaded an exposure bracketing in HDR projects you will see the HDR creation area which consists of the work areas for **exposure bracketings** on the left of the screen and the **HDR algorithms** on the right. You can see your HDR image in the centre of the screen.

With the uppermost check box you can exclude an image from the exposure bracketing or include it again.

Underneath you can find the miniature view of the exposure bracketing image. If you want to see it in full size, simply left-click on it. Left-click again if you want to switch the view back to the final HDR image.

On the right of the colour view you can see the weight matrix for the exposure bracketing.

This greyscale image can be interpreted as follows:

- Bright pixels indicate that this area will have a heavy influence on the final HDR image.
- Dark pixels indicate that this area will have a lesser influence on the final HDR image.
The weight matrix helps you to determine how strongly the HDR result will be influenced by a certain area of an image from the exposure bracketing.

Note: In chapter 3.3.2 the weight matrix will be very important for understanding how an HDR image is created.

On the right of the weight matrix you can see a rectangular button. This is the weighting colour that will be important in a later chapter (see chapter 5, HDR paint mode).

By clicking on the minus button below the weighting colour the corresponding image will be deleted from the exposure bracketing.

### 3.2.1 Synthetic exposure bracketing images

**Synthetic exposure bracketing images** are a special feature of HDR projects. You can use these images in order to fill up gaps in the exposure bracketing. This method can be used, among other things, to create HDR from a single image. Whenever you upload a single image two synthetic images will be automatically added, with one of them having a shorter exposure and the other having a longer exposure. When you upload a bracketing with two images one additional synthetic image will be added. This way you will always have at least three images in every exposure bracketing at your disposal.

---

**3.2.2 Global weight & Exposure value**

Every exposure bracketing image has two control panels, irrespective of whether it is an original image or a synthetic one. With these two control panels—global weight and exposure value (EV)—you can influence the outcome of the HDR creation enormously.

The example on the left shows an exposure bracketing directly after uploading it. The control panels for global weight and for exposure value are both set to the middle.

The example in the middle shows the first bracketed image (DSC03641.jpg) with a higher global value. This image now has a stronger influence on your final HDR image which is indicated by the brighter look of the global weight view. Your final HDR image will be a little bit darker as a result because the image with the shorter exposure has a stronger influence during the HDR fusion.

The example on the right shows a higher exposure for the image in the middle, which is also the master image (DSC03642.jpg). This influences the final HDR image twofold: this bracketed image is now brighter which means that you are changing the uploaded exposure bracketing in the memory. Furthermore, the weight of the image per pixel changes because it is now a modified exposure bracketing image.
3.3 The work area of HDR algorithms

You can find the HDR algorithms together with the parameter controls on the right of the interface.

An HDR algorithm is a mathematical code that determines the weight (see the weight view in the exposure bracketing) of the single bracketed images per pixel. Every algorithm affects the final HDR image in a different way and has, depending on the motif, its strengths and weaknesses.

3.3.1 An overview of HDR algorithms

HDR projects puts seven different HDR algorithms at your disposal:

- **Average**: The average is the simplest form of HDR creation and creates an average from all of the exposure bracketed images.

- **Entropy**: Entropy in information theory is a degree of measurement for information density. If you use this for HDR creation, you have an algorithm that measures the information density of the exposure bracketing images per pixel and calculates from those the weight for the HDR creation. This is a very stable method which is also set as the default algorithm for HDR projects.

- **Luminance distance**: Luminance distance uses the average brightness distances in an image as a method of weighting an image for HDR creation. This method is also universally useful, so it can be applied to almost any exposure bracketing.

- **Colourmix**: The colourmix method uses the colouring of the pixels as a unit for measuring the weight of an image. It is especially useful for bracketings that only have a slight brightness difference in certain areas of the images, such as images containing fog, smoke or clouds.

- **Luminance entropy**: Luminance entropy is a combined method using both luminance distance and entropy.

- **Luminance RGB**: This method combines luminance distance and colour mix and is especially suited for landscape images.

- **Linear luminance**: Linear luminance directly uses the luminance (brightness) for the weighting of the pixels.
3.3.2 Parameters of HDR algorithms

Underneath the list of HDR algorithms you can see up to four control bars for fine-tuning the parameters.

- **Denoising**: Denoising directly affects the HDR image and indicates its strength in a percentage. A value of 0% leads to no pixels with noise being deleted; while a high value will denoise the HDR image strongly. The latter automatically leads to an image with less sharpness.

- **Smoothing**: Smoothing influences the weighting matrixes that emerge from the HDR algorithms. It indicates the smoothing of images depending on image resolution in a percentage. A value of 50% means that the weight matrixes will be smoothed over with an expansion of 50% of the resolution using a Gaussian blur.

If you take a look at the windows in this example, you may notice that the "content" of the windows will be displayed better with a harder smoothing (upper picture). HDR smoothing is a very strong tool that you can use to optimise your HDR images. Unfortunately, finding the best smoothing value cannot be performed automatically using mathematics because it depends heavily on the user’s individual taste.

- **Night/daytime**: With this option you can adjust the HDR algorithm to an image taken at night or during the day. Move the control panel to the left (night) if your exposure bracketing is closer to an image taken at night; move it to the right (day) if it is more like an image taken during the day.

Note: A smoothing value of 0% (no smoothing at all) is only viable for the algorithms *Entropy* and *Luminance distance*. The algorithms further down are only suitable for HDR creation without smoothing in a few special cases.

- **Halo adjustment**: This option deals with a typical problem of HDR creation: the creation of Halo effects (HDR shadows). In the image on the left you can see a minor adjustment—visible halos appear at the transition to the sky. The image on the right has a halo adjustment of 85% which lets all halo effects disappear.

Note: A smoothing value of 0% (no smoothing at all) is only viable for the algorithms *Entropy* and *Luminance distance*. The algorithms further down are only suitable for HDR creation without smoothing in a few special cases.
4. Tone mapping / post-processing

After having created and adjusted your HDR image, the next step is the tone mapping that you saw during HDR preparation (local tonal value compression), combined with the post-processing of the image.

HDR projects offers you different algorithms in the tone mapping section and a variety of post-processing effects including different default settings.

4.1 Default settings

With the default settings you can achieve a nice result with a single click of the mouse. The default settings are separated into eight categories, six of them being theme based from Landscape to Artistic, plus the two options Custom and All. After you have decided which category to use choose one of the default settings by simply clicking on the corresponding preview image. These previews are miniatures of the HDR image and are being calculated in real time, which means that you get a first impression of the effect from the tone mapping on the final picture while you are browsing through them. (see page 43).

HDR does not equal tone mapping and post-processing

It has been mentioned before that tone mapping is the final step in image editing that enables the dynamic range of an HDR file to be displayed on screens and printers. As you can see, the use of sophisticated effects seems to be the thing to do in this case, and can also be concluded from the large variety of default settings in HDR projects. But please keep in mind that contrary to popular opinion, HDR is not the same as a tone mapping with as many effects as possible. HDR is all about displaying a dynamic range that cannot be achieved with standard methods. Therefore you should only rarely use the effect-based default settings and go for the natural algorithms instead.

Tone mapping is necessary since standard screens and printers cannot display the whole dynamic range of an HDR file. The heightened tonal value spectrum of the HDR file is compressed (tonal value compression) in order to display a simulated HDR file that is optimised for being displayed on standard output devices.
4.1 Default settings (continued)

Additionally to the theme-based default settings there are two more categories: Custom and All. Your custom-made default settings will be saved under Custom while All will let you combine all available default settings.

The default settings have diverging functions that you can find on the right of the respective preview image.

The top two functions are available for all default settings:

**Duplicate:** With this you can copy the default settings into the Custom category.

**Restore to saved default settings:** This function resets the default setting to a saved state.

You can modify the default settings without worrying about losing them because you can always reset them to their default state.

The three functions below these two are only available for your custom-made default settings in order to protect your installed data. That way it is assured that all the default settings from your installation are always available to you and cannot be deleted or modified by accident.

**Overwrite default setting:** If you click on this function, the default settings will be overwritten with the current settings. The previous settings will be lost.

**Rename default setting:** Use this function to rename your default setting. Enter the new name and confirm by clicking OK.

**Delete default setting:** In order to delete a preset permanently, click on this function. After confirming that you really want to delete it, this default setting will be erased from your system.

4.1.1 Combining default settings

Use the button Combine default settings directly underneath the categories to combine two default settings. In the top part of the window you can choose two existing default settings from the list and combine them to form a new default setting by clicking on the button Combine. This new setting will be saved to your Custom default settings. Our example shows a combination of the default settings artistic fluid and natural brighten to a new default setting Custom fluid + brighten, which leads to radiant colours similar to a Bokeh effect (see image below).

**Note:** The sequence that you use to combine the default settings has a major influence on your result. Test different variants and you will often produce surprising image effects!
4.2 Tone mapping expert mode

You can find the **expert mode panel** for tone mapping and post-processing on the right of the screen. With this you can configure the whole image editing, test new effect combinations or edit default settings according to your wishes.

There are four different lists in this panel:

1. **Tone mapping algorithms**
2. **Post-processing filters**
3. **Effects you have selected**
4. **Parameters of your selected effects**

Tone mapping algorithms and post-processing filters are filters that you can opt for, and the selected filters are those which are represented in the current calculation. The way these filters work and how to transfer the filters into the list of selected filters will be explained in the following chapters (4.2.1 to 4.2.3).

### 4.2.1 Tone mapping algorithms

Tone mapping algorithms are purely there for enhancing the quality of the image. HDR projects lets you choose from five different algorithms that can each be used on its own or combined.

In order to add a tone mapping to your list of selected filters simply double-click on it. Alternatively, you can right-click on it to open a context menu.

**Gradient tone mapping**: This is a method with strong effects that is suitable for motifs with weak colours and high contrasts.

**Average tone mapping**: This is a very stable method and can be used for almost any motif.

**Average exponent tone mapping**: This is a stable method that has a strong impact on dark areas. It is especially suitable for images taken in tunnels or vaults.

**Sigmoid tone mapping**: Sigmoid tone mapping is a very special method that has been optimised for motifs with strong highlighted areas.

**Surreal tone mapping**: A very intensive method that provides a good basis for extreme HDR images.

### 4.2.2 Post-processing filters

This list contains 52 different filters for post-processing. They are subdivided into six categories.

Depending on the category the filters are highlighted with a different colour:

- **Yellow**: Edge effects
- **Green**: Geometry effects
- **Cyan**: Exposure effects
- **Blue**: Colour effects
- **Violet**: Scrim diffuser effects
- **Pink**: Artistic effects
In this list you can find all the classic post-processing effects of the HDR area, such as:

- Detail strengthener
- Denoise and sharpness filter
- Gradation curves
- Greyscale conversion
- Lens correction, rotation and zoom
- Lights and shadows
- local/manual black/white point (Pipette or chromatic circle)
- Correction of chromatic aberrations
- Colour adaptation by tone, brightness, balance, temperature
- Blurring
- Colour tone diffusion

You can add an effect by double-clicking on it or via the context menu (right-click):

**Add effect:** Adds the effect to the list of filters.
**Show all effect groups:** Shows all six effect groups. Now you can see all the available effects.
**All effect groups off:** Hides all of the six effect groups.
**Filter enhancers on/off:** (De-)Activates filter enhancers.
**Geometry effects on/off:** (De-)Activates geometry effects.
**Exposure effects on/off:** (De-)Activates exposure effects.
**Colour effects on/off:** (De-)Activates colour effects.
**Blurring effects on/off:** (De-)Activates blurring effects.
**Artistic effects on/off:** (De-)Activates artistic effects.
**Display panorama effects only:** Shows only panorama effects.

### 4.2.3 Selected effects

The list of the effects that you have selected is the core of the tone mapping and post-processing area. Here you can manage all of the post-processing and the parameters for every single effect.

In the image on the right, the tone mapping list and the post-processing effects of the expert mode have been hidden for a better overview.

In our example we have an effect chain of three different filters: Average exponent tone mapping, median noise suppression and automatic black/white point.

These three filters will be automatically applied to the HDR image one after the other and will result in a final tone mapping image.

In order to temporarily deactivate an effect simply click on the check box in front of the effect name. Double-clicking on an effect will remove it from the list.

In the list of effects you have selected you also have a context menu with numerous options:

**(De-)Activate effect:** (De-)Activates the chosen effect.
**Activate all effects:** Activates all the effects in the list.
**Activate all other effects:** Activates all effects up to the one you have selected; all effects below this one will be deactivated.
**Activate this effect only:** Activates this effect only. All the other effects will be deactivated.
**Deactivate all effects:** Deactivates all effects in the list.
**Duplicate effect:** Creates a duplicate of the selected effect and copies it to the end of the list.
**Restore effect:** Restores the selected effect to its default settings.

**Send to top of list:** Moves the selected effect to the top of the list.

**Send to end of list:** Moves the selected effect to the end of the list.

**Delete effect:** Removes the selected effect from the list.

**Remove all the effects:** Removes all the effects from the list.

In order to rearrange the order in which the effects appear in the list you can simply drag & drop them within the list. Note: The sequence in which the effects appear in the list can have a major influence on the resulting image.

The image on the left has significantly less detail inside the archway. If you use the Brightness-Contrast-Gamma effect first on the image, you will darken the areas that are already dark and cause brightness breaks—the following tone mapping cannot compensate for this. Compare with the image on the right where a tone mapping has been conducted beforehand. The details in the archway are a lot more visible.

### 4.2.3.1 Parametrisation

You can change the parameters of single effects in the panel below the list of your selected effects. The parameters of your currently selected effect will be displayed here. There are different types of parameters: Sliders, Splines, Colours & Pipette, Positions and Lines. Some effects may have up to eight parameters.

**Sliders:** Sliders are the simplest form of parametrisation. Simply move the slider in order to change the value that influences the effect to the left (smaller value) or to the right (bigger value). Alternatively, you can enter your desired value directly via the number field above the slider.

In our example you can see the parameters for the effect **Colour balance** which consists of three sliders for the balancing.

**Splines:** The curve parameters are divided into two types: gradation curves that have a direct effect on the images’ brightness, and mask curves that define the intensity of an effect on the different brightness areas within the image.

Both types of curves can be modified the same way. Every curve (Spline) has six control points. These points (with the exception of the outermost points) can be dragged horizontally and vertically within the frame.

**Gradation curve:** In our example you can see a gradation curve that directly affects the brightness. The diagonal line is the standard status of the curve because it creates the original image. If you drag one of the points

---

**HDR projects 2**

**Tone mapping / post-processing**
to the bottom, the pixels with the corresponding brightness will become darker and vice versa. In addition, you can find a box with default settings for the curve on the top right. In our example we have used the default setting overexposed.

In the background you can see a preview of what the gradation curve will do displayed in greyscale (representing the different brightnesses). This preview is calculated in real time as you move a control point.

**Mask curve:** In our example you can see a mask curve. This curve influences the intensity of an effect (here Colour intensity) on the different brightness areas in the image. If you drag one of the points towards the bottom, the pixels of the corresponding brightness will be less affected by this effect and vice versa.

You can find a box with default settings on the top right as well. In our example we have chosen the default setting Shadows. For the colour intensity in our example this means that an increase of 150% will be calculated completely for very dark pixels, and pixels with about 30% brightness will only be affected by half and so on.

The preview in the mask curve shows the effect’s intensity from black (no effect) to white (full effect) in real time while you modify the curve.

**5. HDR paint mode**

HDR paint mode is a complex tool that lets you edit every area of the the final HDR image manually.

In order to activate paint mode click on the button **Edit weightings** in the main toolbar or the button **Select Weighting Colour** in the exposure bracketing. Alternatively just press **F6**.

If HDR paint mode is activated, several areas in the interface change and additional functions are now available in the user interface. You can see that the images in the exposure bracketing (left) have been allocated to the colours red, green and blue. If you have more than three images in the bracketing, the master image will be allocated with green and the two active images closest to it will be red and blue.

This colour allocation is important for the display and for the paint mode.

Furthermore, a new toolbar has appeared below the main toolbar. It contains the functions that are relevant for paint mode:

1. **Work colour** Switch between red, green and blue
2. Activate brush mode to **Increase weight**
3. Activate brush mode to use **Blurring**
4. Activate brush mode to **Delete**
5. Activate **Stamping mode**
6. Activate brush mode to **Reduce weight**
7. Perform automatic **ghosting correction**
8. Delete all painted **weightings**
9. Select **Brush size**
10. **HDR blending mode:** HDR image, control panel from 0% to 100%, weighting view

These buttons and their functions will be explained in the following chapters.
5.1 Weighting view vs. HDR view
As soon as you enter paint mode for the first time you will notice a colour change in your image.
In order to demonstrate this effect put the control panel HDR/Weighting to 100%. This results in only the weights being displayed in the image area.
In our example the HDR smoothing has been additionally reduced to 0% in order to have a better view of the weights. In order to understand this view you have to take a look at the colour allocation in the exposure bracketing:

- the dark exposure bracketing image is displayed in red
- the middle exposure bracketing image is displayed in green
- the bright exposure bracketing image is displayed in blue

The view in the middle shows you the HDR weighting in correspondence to the selected colour in the exposure bracketing.

The blue areas (the trees in our motif, see p. 54) in the exposure bracketing will mostly be taken from the brightest image of the exposure bracketing when it comes to the HDR creation, and the red/yellow areas (the river in our motif) mostly from the darkest image of the exposure bracketing (with a small part from the middle exposure bracketing). What you can see here is the HDR Fusion that is normally not visible to the naked eye.

5.2 Selecting the work colour
For the first step in manually modifying HDR creation you have to select a work colour. In our example you can choose between the three work colours red, green and blue. Every colour represents the image of the exposure bracketing it has been allocated to. If you want to modify the weighting of the dark exposure bracketing image in our example, you will have to select the work colour red.

5.3 Brush mode Increase weighting
Here you can increase the selected weighting corresponding to the work colour. To do so simply paint the selected colour into the image using your mouse.

In order to see the effect of what you have just painted set the control panel HDR/Weighting to 0%. The new HDR image will subsequently be calculated and displayed.
As you can see in the HDR image the area you've painted red is now darker because you have increased the weighting of the dark exposure bracketing in this section.

You can change any area of the HDR image like this in any direction you like, for example in order to highlight or fade certain structures.

5.4 Brush mode Blurring

The brush mode Blurring smooths out certain areas in the weightings of the selected work colour. If you have for example selected red as your work colour, you can now smooth out only those weightings of the exposure bracketing that are allocated to the colour red.

**Note:** You can only blur those areas that you have painted beforehand. The weightings based on the HDR algorithms cannot be smoothed out this way. If you want to smooth out these areas, use the control panel Smoothing in the HDR algorithm area.

5.5 Brush mode Delete

With the brush mode Delete you can reset areas that you have painted to their original state. The original state being the weightings that were calculated with the help of the HDR algorithm. In the example image on the next page the middle of the area that was marked with red has been deleted. You can see that the original HDR algorithm reappears (the red dot in the middle is the brush attached to the mouse cursor).

**Note:** It may be helpful to paint over the edges in the HDR weightings with the blur brush after deleting something in order to avoid unwanted edges in the HDR image.

5.6 Stamping mode

Stamping mode is available for the functions Increase Weighting, Blurring and Delete that were explained in chapters 5.3, 5.4 and 5.5, and can be activated in addition to those. Stamping mode is not available for the Reduce weighting mode. When stamping mode is activated the functions mentioned above don’t only affect the selected weightings but all the weightings in all of the exposure bracketings, such as when you are copying something by tracing.

This has the following effect:

**Increase weighting in stamping mode:** The weighting is increased on the exposure bracketing images with the allocated colour, while it is reduced by the same summed up intensity on the other exposure bracketing images.

If you have an exposure bracketing with three images, like in our example, and if you add the dark image in red to that, the other bracketed images (two in our example) will be decreased by the same amount. (In our example every picture will be decreased by half of the addition.)

When you perform an addition in stamping mode what you get is the highlighting of a certain area of the image. In our example the trees in the foreground are solely taken from the dark bracketed image when the HDR image is created.
Blurring in stamping mode: When you activate stamping mode together with Blurring you can perform blurring for every image of the exposure bracketing in the specified area. This comes in handy when you want to smooth some edges that you created when you used stamping mode to increase or delete weightings.

Delete with stamping mode: The delete function can be used in stamping mode to affect every image of the exposure bracketing at once.

5.7 Brush mode Reduce weighting
This function reduces the selected weighting corresponding to the work colour. To do so, simply paint the selected colour into the image using the mouse.

In our example below the weighting towards the HDR image of the bracketed image with the colour red has been reduced for the area with the river on the bottom of the image. The dark bracketed image now no longer influences the final HDR image.

6. Batch processing
HDR projects’ Batch processing allows you to automatically process multiple exposure bracketings. You can access this feature via the Extras menu or using the shortcut ⌘ B.

The Batch processing window is subdivided into the following areas:

1. Source file
2. Results
3. Processing settings
4. Exposure bracketing
5. Progress bar
6.1 Source file

Start by selecting a source directory containing the single images (HDR from a single image) and/or the exposure bracketing. These files can also be mixed—the automatic exposure bracketing detection will sort them for you.

With the include all subdirectories option you can not only search through the selected folder for images but also through all the subfolders and their respective subfolders. This is called “recursive file search”.

Note: Please take into account that searching through a folder with many subfolders might take some time. Therefore it is best not to select "C:" as the folder that you want to start searching through.

6.1.1 Allocation/Automatic exposure bracketing detection

The allocation and automatic exposure bracketing detection takes care of sorting through images for you. You can choose from several modes:

Automatic allocation: The automatic allocation uploads all images and finds those images that belong to an exposure bracketing. In this process the luminance and image congruence are taken into account which ensures a very accurate automatic detection.

As you can see in our example below HDR projects has correctly identified and allocated the 20 exposure bracketings that have been uploaded. Note: The separate elements of the exposure bracketing area will be explained in detail in chapter 6.4.

Single images: The option Single images sorts every image into a single exposure bracketing. This mode is especially suited to working with bracketings that were taken during the shooting of a film.

2-image to 9-image groups: If you have taken HDR films, or if you are sure that you only have exposure bracketings with the same number of images in your folder, you can select this option. The file names of the final images will be created one after the other in order to make it possible for you to use the edited images in a video editing software. In our example the image sequence of 402 images has been sorted into 134 exposure bracketings each containing three images.

6.2 Results

In the area Results you can determine where to save the final images from the batch processing. To do so, click on the button Target directory (...) or enter the target folder directly into the text field.

6.2.1 Format

You can choose from 8 different formats for the Format of the final images.

You can pick between .jpg and .tif, two 8-bit (LDR) formats and three 16-bit (HDR) formats. Jpg-images will always be saved in the highest possible quality and TIF-files will be saved without compression and with no data loss. Furthermore, you can select the PNG-format and Open EXR, Portable Floatmap and Radiance RGBE for further editing in web-based editors.
**6.2.1.1 Batch processing with re-sort mode**

The **re-sort mode** of the batch processing helps you to sort through your exposure bracketings and images on your hard drive. Select a source directory containing unsorted bracketing images and activate the option **re-sort mode** in the Results area. Then select a target directory into which the bracketed images from the source directory should be sorted. Use this function with care, as it will re-sort the image files on your hard drive. The files will be cut from the source directory and pasted into new folders based on the exposure bracketing they belong to.

**6.3 Processing settings**

With the **Processing settings** you can select the settings for the HDR creation and the tone mapping.

**HDR default settings:** The HDR default settings offer three to four default settings per HDR algorithm. Simply select the default setting you would like to use from the list.

**Tone mapping:** The tone mapping default setting contains all the defaults from the tone mapping/post-processing area, including your custom-made default settings (**Custom**). This means you can create a custom setting before batch processing and then use it with several exposure bracketings at once. As soon as you have chosen the HDR default settings and the tone mapping all the pictures in the preview will be re-calculated, which means that you always have a preview of what the results of your latest changes will be like.

**HDR preparation:** The HDR preparation in Windows opens a menu that lets you set the upload options including the colour space, white balance, image alignment, etc.

**Note:** When you’re working with a Macintosh this dialogue will appear before the batch processing window is displayed.

**6.4 Exposure bracketing preview**

The **exposure bracketing preview** gives you information on the exposure bracketings that have been found. At the top of the area you can see the number of exposure bracketings that have been allocated. Underneath you will find three buttons that let you globally switch exposure bracketings on and off:

- **Activate all exposure bracketing:** Activates all allocated exposure bracketings for calculation (default setting).
- **Deactivate all exposure bracketing:** Removes all allocated exposure bracketings from the calculation.
- **Remove single images:** Removes all exposure bracketings that consist of a single image. You can use this option if the software has miscalculated an exposure bracketing due to a very bright or a very dark image.

### 6.4.1 Allocated exposure bracketings

Every exposure bracketing that has been found has a large variety of functions to choose from. With the option on the top left you can deselect an exposure bracketing from the calculation or select it again. The file name for the target file will be created automatically. In our example you can see that the file name is **DSC_2704_05_06_07_08_09_10_11_NEF**. This means that the first image was called DSC_2704, the file format is .NEF.

Move the cursor over a miniature preview in order to take a look at a bigger preview of the image.
For the bracketed pictures on the left this is a larger preview of the corresponding exposure bracketing image. For the HDR tone mapping preview on the right you will receive a bigger preview of your final image.

Note: All the previews will be recalculated immediately if you make any changes. You can experiment with the HDR settings and the tone mapping settings and immediately see the effect in the preview.

Furthermore, you can right-click on an exposure bracketing or a bracketed image in order to bring up a context menu with the following options:

- **Open as project**: Opens this bracketing as a project in HDR projects. You can use the batch processing as a browser for your exposure bracketings as well.
- **(De-)Activate exposure bracketing**: (De-)activates this exposure bracketing for batch processing.
- **Delete exposure bracketing**: Deletes this bracketing from batch processing.
- **Move image to new series**: Moves the selected image to a new exposure bracketing.
- **Cut image**: Removes an image and saves it in the clipboard.
- **Paste image**: Pastes the image from the clipboard into the exposure bracketing. Warning: Only images with an identical resolution can be pasted into an existing exposure bracketing.
- **Delete image**: Removes the picture from the bracketing.

**6.5 Progress bar**

The **Progress bar** informs you of the progress of the exposure bracketing allocation. This can vary depending on the number of allocated pictures. If the current process is complete, you can find a hint above the progress bar that tells you what step to perform next.

**6.6 Direct start button**

The button **Start** on the bottom right has a special function: the direct start. If you have set everything up before selecting a source directory, you can give the order to start the batch processing before the exposure bracketing is complete. HDR projects will automatically start with the batch processing as soon as the allocation of the exposure bracketings is complete.

The **Start** button will be marked as already pressed and the calculation starts automatically as soon as the progress of the exposure bracketing allocation reaches 100%.

**6.7 Preview during processing**

During batch processing you will receive detailed information of all the processing instances.

You will receive information about the HDR calculation, the tone mapping and the saving process for every image in the batch processing. Additionally, the remaining calculation time will be displayed. This information is an estimation based on the time needed for those exposure bracketings that have already been calculated.
7. Ports and plugins

HDR projects 2 contains several ports to a variety of Adobe products: Adobe Photoshop CS6®, Adobe Lightroom 4® and Adobe Photoshop Elements 11® plus one external image editor that can be defined freely.

7.1 Configuration with HDR projects

You can access the compatibility settings via the Settings option in the External Programs area. Here you can set four different external programs of which one can be active at a time. The button [... ] opens a file browser window where you can (depending on your system) select the respective .exe file (Windows) or .app file (Mac OS X).

Click the check box in front of the desired external program in order to determine which software should be the active program.

In our example the external image editor has been set to HDR projects.exe and Photoshop Elements 11 was linked to the file PhotoshopElementsEditor.exe.

Note: For Photoshop Elements it is important to declare the editor as an external program.

7.2 Configuration of the plugins for Photoshop CS6 and Photoshop Elements

Generally we have to differentiate between Mac OS X and Windows because the configuration process largely varies depending on the operation system you are working with.

Mac OS X: Copy the plugins for Photoshop CS6 and Photoshop Elements 11 into the respective directory on your hard drive (due to write permissions this process can unfortunately not be automated). After you have copied the plugins into the correct directory they are ready for use.

You can access the plugins in Photoshop-programs via the menu path File -> Export -> HDR projects...
Windows: If the installation of the Photoshop CS6 or Photoshop Elements 11 plugins does not work correctly you can perform the installation of these plugins manually.

For Photoshop CS6 you have to know if your installation is for 32-bit (x86) or 64-bit (x64). You can find this out by checking whether the installation files have been copied into the directory Program Files or into Program Files (x86). Copy the 64-bit plugin HDRProjects2_PH6_x64.8be into the directory with the Photoshop CS6 64-bit installation, and the 32-bit plugin HDRProjects2_PH6_x86.8be into the directory with the 32-bit installation of Photoshop CS6.

If you want to use Photoshop Elements 11, simply copy the file HDRProjects2_PH5_x86.8be into the Plugins folder.

7.3 Configuration of Adobe Lightroom 4

If you open the window Export in the File menu of Lightroom 4, you will find the following 2 settings:

1 File settings: Here you can select the export format for Adobe Lightroom 4. In our example we have a .TIFF image file without compression and with a colour depth of 16-bits per channel. This setting will ensure a quick calculation process while maintaining a high quality image. You can work with .jpg images as well but we recommend not to do so because you might experience a loss of quality with this format and they only have a colour depth of 8-bits per channel.

2 Post-processing: For the area After Export select Open in another application... and set the application to HDR projects 2. If you are working with Windows, select the HDR projects.exe of your installation.

If you click on Export, HDR projects will start and the selected image will be uploaded to Lightroom 4.

7.4 Triggering external programs

If you have properly configured the external programs and all the plugins have been copied to the correct locations, you can trigger external programs with the button Open final image in external program.